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Welcome

This guide explains how to use the Object Viewer utility. The 
Object Viewer utility provides diagnostic and performance 
information about ApplicationObjects. The Object Viewer 
utility can be accessed from the Integrated Development 
Environment (IDE) and the Platform Manager in the System 
Management Console (SMC) suite of utilities.

You can view this document online or you can print it, in part 
or whole, by using the Adobe Acrobat Reader.

Documentation Conventions
This documentation uses the following conventions:

Convention Used for

Initial Capitals Paths and file names.

Bold Menus, commands, dialog box names, 
and dialog box options.

Monospace Code samples and display text.
Object Viewer User’s Guide
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Technical Support
Wonderware Technical Support offers a variety of support 
options to answer any questions on Wonderware products 
and their implementation.

Before you contact Technical Support, refer to the relevant 
section(s) in this documentation for a possible solution to the 
problem. If you need to contact technical support for help, 
have the following information ready:

• The type and version of the operating system you are 
using.

• Details of how to recreate the problem.

• The exact wording of the error messages you saw.

• Any relevant output listing from the Log Viewer or any 
other diagnostic applications.

• Details of what you did to try to solve the problem(s) and 
your results.

• If known, the Wonderware Technical Support case 
number assigned to your problem, if this is an ongoing 
problem.
Object Viewer User’s Guide
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Chapter 1

Overview

Object Viewer provides performance and diagnostic 
information about ApplicationObjects. You an use Object 
Viewer to show performance parameters, resource 
consumption, and reliability measurements of objects you 
select.

In addition to viewing an object’s data value, data quality, 
and the communication status of the object, you can also 
modify some of the object’s attributes for diagnostic testing. 
Modifications can include adjusting timing parameters and 
setting objects in an execution or idle mode.

Object Viewer runs with minimal ArchestrA and operating 
system requirements.

Using Object Viewer you can:

• View the data type, data quality, data value, timestamp, 
and communication status of ApplicationObject 
attributes.

• Do diagnostic testing on ApplicationObjects.

• Modify selected ApplicationObject attributes.
Object Viewer User’s Guide
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Availability 
Object Viewer is a common component of any Galaxy 
application and is available from any workstation in the 
application with a deployed WinPlatform. You do not need to 
install the utility on each workstation.

Starting Object Viewer 
You can use Object Viewer from any workstation that is part 
of your Galaxy application.

To start Object Viewer

1 Click Start, point to Wonderware, and click System 
Management Console.

2 In the console tree, expand the Platform Manager to show 
the list of Galaxies, and then expand a Galaxy to show a 
list of platforms.

3 Right-click a platform, and then click Launch Object 
Viewer.

You can also start the Object Viewer from the ArchestrA IDE 
by right-clicking a deployed object and then clicking View in 
Object Viewer.
Object Viewer User’s Guide
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Navigating In Object Viewer
The main window of the Object Viewer is composed of three 
areas: 

• Console tree on the left

• Details pane on the right

• Watch window at the bottom 

The console tree works like Windows Explorer. Use the plus 
(+) and minus (-) signs to expand or hide the nested list items 
shown in the pane. When you select an object in the console 
tree, its associated attributes and their properties are shown 
in the details pane.

Drag a specific set of attributes of interest to a watch window 
to monitor their Quality, Status, Timestamp, and Value as you 
manipulate them and other attributes that affect their data 
values. You can save the contents of a watch window to a file 
for future reference.

Watch Window

Console Tree Details Pane
Object Viewer User’s Guide
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Finding Objects
You can use the Find dialog box to search for an object in your 
Galaxy application.

To find an object by name

1 On the Edit menu, click Find Object. 

2 Select the Search by Name check box.
3 In the Find What box, type or select a tag name. The Find 

button becomes active.
4 In the Which Name area, select either Tagname or 

Hierarchical.
5 In the Search Criteria area, click a search option.
6 In the Search Scope area, select a platform and an engine.
7 In the Only Show Objects area, select the That Are 

Quarantined and That Are OffScan check boxes to limit the 
search scope.

8 Click Find.
Object Viewer User’s Guide
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To find an object without using the name

1 On the Edit menu, click Find Object.
2 Clear the Search by Name check box.
3 In the Search Scope area, select a platform and an engine.
4 In the Only Show Objects area, select the That Are 

Quarantined and That Are OffScan check boxes to limit the 
search scope.

5 Click Find.

Closing Object Viewer
By default, when you close the Object Viewer, your settings 
are not saved, including the attributes you selected for the 
Watch window. You can choose to save the watch windows 
you create. For more information about saving watch 
windows, see Saving a Watch Window on page 19.

To close the Object Viewer

On the File menu, click Exit.
Object Viewer User’s Guide
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Chapter 2

Viewing Attributes

Using Object Viewer, you can view the attributes of all 
ApplicationObjects in your Galaxy application from any 
workstation used in the application.

Viewing an Object’s Attribute Data 
All AutomationObjects consist of attributes and common 
properties such as data type, initial value, and value range. 
Each object’s set of attributes appears in the details pane 
when you select the object in the console tree.

To view an object’s attribute data

1 Start Object Viewer. Object Viewer’s main window 
appears. The object in focus in the IDE or Platform 
Manager is put into focus in the console tree of the Object 
Viewer.

2 To view another object’s attributes, select the object in 
the console tree.
Object Viewer User’s Guide
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Quality
Every readable attribute is assigned a quality property that 
matches one of four categories. 

Status
The status of an ApplicationObject’s attribute describes 
whether a particular Read or Write request succeeded or 
failed. Possible status conditions include: 

Quality Description 

Good Data is good and can be used.

Uncertain Data is questionable, but can be used.

Initializing Data is not yet available, but will be 
soon.

Bad Data cannot be used.

Status Description 

OK Operation completed 
successfully.

Pending Request is received, but is not 
yet complete. A transitory status.

Warning Operation completed 
successfully, but with some 
warning condition. Applies only 
to Write actions.

Communication Error Request failed due to an error 
communicating with the target 
ApplicationObject.

Configuration Error Request failed due to an error in 
configuration.

Operational Error Request failed due to an operator 
error.

Software Error Request failed due to an internal 
software error.

Security Error Request failed due to insufficient 
security access rights.

Other Error All other errors.
Object Viewer User’s Guide
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Understanding Failed Requests
When a failure occurs during a request, the details of the 
error appear in a dialog box, which contains the source of the 
error and a description of the error. 

Communication Errors
Communication errors include the following: 

Source Description Reason 

Requesting NMX Request Timed Out A message was not processed in a timely 
manner. 

Requesting NMX Communication 
Error: Platform 
communication 
error

Attempt to get or set an attribute from an 
ApplicationObject on a remote platform 
with the network down between the two 
platforms. 

Responding NMX Communication 
Error: Engine 
communication 
error

Attempt to get or set an attribute from an 
ApplicationObject on a remote engine 
that is currently not running, but 
deployed. 

Responding NMX Communication 
Error: Engine 
communication 
error

Attempt to get or set an attribute from an 
ApplicationObject on a remote engine, 
but that remote engine is currently 
undeployed while the remote platform is 
deployed. 

Responding 
Automation 
Object 

Index out of range Attempt to get or set an attribute from an 
ApplicationObject attribute that is an 
array, but specified an array index that is 
out of range. 
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Configuration Errors
Configuration errors include the following: 

Operational Errors
Operational errors include the following: 

Source Description Reason 

Responding LMX Invalid Object ID Attempt to get or set an attribute from an 
ApplicationObject on a remote engine, but 
that remote ApplicationObject is 
currently undeployed while the remote 
engine is deployed. 

Requesting NMX Invalid Platform ID Attempt to get or set an attribute from an 
ApplicationObject on a remote platform, 
but that remote platform is currently 
undeployed. 

Requesting LMX Invalid reference Attempt to get or set an attribute from an 
ApplicationObject that is not yet 
configured in the system. A bad reference. 

Responding NMX Invalid Engine ID Attempt to get or set an attribute from an 
ApplicationObject on a remote engine, but 
that remote engine is currently 
undeployed while the remote platform is 
deployed. 

Source Description Reason 

Responding 
Automation 
Object 

Attribute not 
writable 

Attempt to set an attribute in an 
ApplicationObject that cannot be written 
to. 

Responding 
Automation 
Object 

Write access denied. Attempt to set an attribute in an 
ApplicationObject that can be written to, 
but that the user cannot write to. This 
can be an operational error ( the 
attribute is read only) or a security error 
(the current user does not have 
permission to write to the attribute).

Responding 
Automation 
Object 

Software error: The 
data to be set was to 
the wrong data type. 

Attempt to set an attribute in an 
ApplicationObject can be written to, but 
with a data type that cannot be written 
to because it cannot be coerced. For 
example, trying to write a Boolean value 
of True to an attribute of type 
QualifiedStruct or QualifiedEnum. 
Object Viewer User’s Guide
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Sorting Data
You can sort the data shown in the details pane in either 
ascending or descending order by clicking any column 
heading. You can show hidden attributes in the details pane 
by selecting the Include hidden command from the Options 
menu. For example, click the Attribute Name heading to sort 
the list by attribute name. Attribute names appear in 
ascending or descending alphabetical order.

Hidden attribute names include leading underscores and 
appear at the top of an ascending order list. For example, the 
following figure shows the _AdviseOnlyActiveEnabled 
hidden attribute, which indicates whether Advanced 
Communication Management is active or not.

Viewing Attributes in a Watch Window 
You can use the watch window to view an attribute or a 
group of attributes apart from the entire list of attributes.

The attributes in the watch window are listed by their 
AttributeReference, which shows which object the attribute 
belongs to.

For example, the AppEngine_001 object contains 
AlarmOnCnt and AlarmUnAckCnt attributes. When you add 
it to a watch list, the object’s tag name is appended to the 
reference string. 
Object Viewer User’s Guide
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 To view selected attributes in a watch list 

1 Select an ApplicationObject from the console tree. A list 
of its attributes appears.

2 Add an attribute to the watch list. 
• In the details pane, right-click an attribute to place it 

on the watch list. Click Add to Watch. The attribute in 
the AttributeReference format, along with its data, 
appears in the watch list.

• Right-click in the watch window and click Add 
Attribute Reference. In the Add Attribute Reference 
dialog box, type the attribute name in the following 
format: Object Reference.Attribute Reference. For 
example, enter SystemArea.ScanState to view the 
ScanState attribute of the SystemArea object.

3 To add a block of attributes to the watch window, hold 
down the SHIFT key and click the left mouse key while 
selecting the first and last attribute of the block. 

4 To add a random list of attributes to the watch window, 
hold down the CTRL key and click the left mouse button 
while selecting attributes.

Adding a Watch Window 
By default, a single watch window appears in the Object 
Viewer. You can add more watch windows to view different 
groups of attributes or view attributes of different 
ApplicationObjects.

Note  If attributes already appear in the watch window, 
right-click away from the list of attributes to open the correct 
shortcut menu. 

To add a watch window 

1 Right-click in the watch window and click Add Watch 
Window. A new watch window appears with the default 
tab name, Watch List 2.

2 To rename the new watch window, right-click it and click 
Rename Tab. Type the name of the watch window in the 
Rename Tab dialog box and click OK.

3 Add attributes to the watch window or add another watch 
window. 

4 Move from one watch window to another by clicking the 
tabs.
Object Viewer User’s Guide
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Saving a Watch Window
You can save a watch window and reuse it each time you 
start Object Viewer.

To save a watch window

1 Right-click in the Watch List and select Save As to save the 
watch list. The Save As dialog box appears.

2 Select the folder path to save the watch window, which is 
an XML file.

3 Click Save.

Removing Attributes from Watch Windows 
The attributes that you add to watch windows remain until 
you remove them or until you close Object Viewer. For 
example, if you are viewing the attributes of an AppEngine 
and place some of its attributes in a watch window, those 
attributes remain even when you select another object in the 
console tree.

Note  This action does not delete the attribute from the object. 
The attribute is viewable in the details pane.

To remove an attribute from a watch window 

In the watch window, right-click the attribute you want 
to remove and click Remove from Watch. The attribute is 
removed from the watch window.
Object Viewer User’s Guide
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Chapter 3

Modifying Attribute Values

You can modify an attribute’s value for diagnostic testing. 
You must have the proper security permissions to do this and 
the attribute’s value must also be changeable.

Before making modifications to any attribute, you must be 
familiar with the attributes and their functions. Also, you 
must understand the effects that changing attribute values 
can have on your Galaxy application.

Attribute Properties
Before modifying an attribute, check its category shown in 
the Category column to determine whether modification is 
possible.

When you try to modify an attribute, a dialog box appears 
that shows the attribute’s type and current value. Use this 
information as a guide for continuing.
Object Viewer User’s Guide
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Category Property
An attribute’s Category property determines if the attribute 
is writable. The only categories that you can write to are:

• Writeable_U

• Writeable_US

• Writeable_UC

• Writeable_USC

• Writeable_UC_Lockable

• Writeable_USC_Lockable

The letters included in the Writable categories mean the 
following: 

Value Property
You can only modify the value property of an attribute shown 
in the Value column. The data type of the attribute shown in 
the Type column indicates the kind of value you can assign to 
the attribute.

Timestamp Property
You can modify the timestamp of an attribute shown in the 
Timestamp column. The Has Quality/Timestamp column shows 
whether an attribute has a timestamp associated with its 
value.

Letter Description 

U UserSets are OK. You can modify these in the 
Object Viewer.

S SupervisorySets are OK. You can modify these 
only with an application function. You cannot 
modify them in the Object Viewer.

C Configtime time sets only. You can modify these 
only when you are configuring the object. You 
cannot modify them in the Object Viewer.
Object Viewer User’s Guide
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Modifying an Attribute Value 
You can only modify attribute values if you have the proper 
privileges and the attribute is writable. Check the Category 
value in the details pane for the attribute you want to 
modify. You cannot modify Calculated and SystemWriteable 
attributes.

Some attribute values affected by the changed attribute are 
updated only after you select the attribute. For example, an 
object’s ScanStateCmd controls the object’s scan state, with 
True being on scan, False being off scan. The object also has a 
ScanState attribute that indicates the current scan state of 
the object. 

Assuming ScanStateCmd and ScanState are False, change 
ScanStateCmd to True. Notice that the object’s ScanState 
attribute value remains False. Select the ScanState 
attribute. Its value changes to True.

To modify an attribute value 

1 Select the object that contains the attribute you want to 
change. 

2 Right-click the attribute and click Modify. A Modify <data 
type> Value dialog boxes appears, related to the data type 
for the selected attribute.  

3 Modify the values as needed.
4 Click Apply and click OK. The new value appears in the 

Value column of the details pane for that attribute.
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Modifying an Attribute from the Watch 
Window 

You can change an attribute’s value while in a watch 
window.

Important  Attributes in the watch window update immediately. 
Attributes in the details pane update when you click them.

To modify an attribute from the watch window

1 In the watch window, double-click the attribute. A dialog 
box related to the attribute’s data type appears.

2 If the attribute is writable, enter or select the new value 
for the attribute.

3 Click Apply and click OK. The new value appears in the 
Value column of the watch window for that attribute.

Viewing Changes Dynamically
Attribute values shown in the details pane are static. You 
must click on an attribute in the details pane to update the 
display.

You may have a configuration in which the Galaxy 
Repository node was upgraded, but other nodes were not 
upgraded. If you use ObjectViewer on the upgraded node to 
view information for attributes from a non-upgraded node, 
the time stamps should not be considered as valid source 
times. In this case, the time stamps reflect the time of the 
local node (the one running ObjectViewer) for the attributes 
running on the non-upgraded node.

Attribute values shown in the watch window are updated 
immediately when the attribute’s value changes. 

For example, objects have two common attributes, 
ScanStateCmd and ScanState. ScanStateCmd controls the 
scan state of the object (on scan or off scan). ScanState shows 
the last known scan state of the object. 

If you place the ScanState attribute in a watch window and 
change the ScanStateCmd attribute in the details pane, the 
ScanState attribute is updated immediately. Instead, if you 
place the ScanStateCmd attribute in a watch window, leave 
the ScanState attribute in the details pane, and then change 
the value of ScanStateCmd, the ScanState attribute is not 
updated until you select it in the details pane.
Object Viewer User’s Guide
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Setting an ApplicationObject On Scan
The on scan state indicates the object’s run-time state, which 
means it is performing its normal processing as part of its 
execute method.

When setting AppEngines on scan: 

• The hosting WinPlatform’s status must also be on scan.

• Any object hosted on the AppEngine is automatically set 
on scan.

To set an ApplicationObject on scan

1 Select the object in the console tree.
2 In the details pane, right-click the ScanStateCmd 

attribute and click Modify. The Modify Boolean Value 
dialog box appears.

3 Assuming the current value is False (off scan), click True, 
click Apply, and then click OK.
Note that the ScanState attribute’s value in the details 
pane remains False (off scan). 

4 To update the display, click the ScanStateCmd attribute.
Object Viewer User’s Guide
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Setting an ApplicationObject Off Scan 
Off scan is the run-time state that indicates that an object is 
idle and not ready to run.

Because WinPlatforms host AppEngines, you must ensure 
that all AppEngines hosted by the WinPlatform are off scan 
before setting the WinPlatform off scan. An error message 
appears if you try to set a WinPlatform off scan while its 
hosted AppEngines are still on scan.

Although AppEngines host other objects, it is not necessary 
for all the objects to be off scan before setting the AppEngine 
off scan. When you set an AppEngine off scan, all of its 
hosted objects are automatically set off scan.

To set an ApplicationObject off scan

1 Select the object in the console tree.
2 In the details pane, right-click the ScanStateCmd 

attribute and click Modify. The Modify Boolean Value 
dialog box appears.

3 Assuming the current value is True (on scan), click the 
False option button, click Apply and then click OK.
Note that the ScanState attribute’s value in the details 
pane remains True (on scan). 

4 To update the attribute value to False, select it.
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